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SCI 550: AP Physics C Summer Assignment, Part 1 

Welcome to AP Physics at King!  Both AP Physics 1 and C 
(mechanics) are college level courses that are sure to challenge 
you and capture your interest.  You can also expect your 
experience with AP Physics to be fun and rewarding.  This 
summer assignment will review all of the prerequisite 
knowledge expected of you.  There are seven parts to this 
assignment, which should not take you any longer than a 
summer reading book assignment.  However, do not overwhelm 
yourself by waiting until the last minute to do the assignment.  
By taking the time to review and understand all parts of the 
assignment, you will help yourself acclimate to the rigor and 
pacing of AP Physics.  You have seen before all of the material 
addressed herein (i.e., basic math skills), but feel free to use books and/or online material if you 
need to refresh your memory.  It is VERY important that this assignment be completed 
individually.  It will be a total waste of your time to copy the assignment from a friend.  The 
summer assignment will be collected on the first day of class.  For those of you who will be taking 
AP Physics C (mechanics), please note that there is a second part to this summer assignment. 

Part 1:  Scientific Notation and Dimensional Analysis 
Many numbers in physics will be provided in scientific notation.  You need to be able to read and 
write numbers in scientific notation.  (This section is to be completed without calculators…all 
work should be done by hand.)  Get used to no calculator!  Most if not all multiple choice 
portions of tests will be completed without a calculator. 

Express the following numbers in scientific notation.  Keep the same unit as provided.  ALL 
answers in physics need their appropriate unit to be correct. 

1. 7,640,000 kg     _______________ 2. 8327.2 s      _______________

3. 0.000000003 m _______________ 4. 0.0093 km/s _______________

Often times multiple numbers in a problem contain scientific notation and will need to be reduced 
by hand.  Before you practice, remember the rules for exponents. 

5. (3 × 106) • (2 × 104) = 6. (1.2 × 104) / (6 × 10-2) =

7. (4 × 108) • (5 × 10-3) = 8. (7 × 103)2 =

9. (8 × 103) / (2 × 105) = 10. (2 × 10-3)3 =



Fill in the power and the symbol for the following unit prefixes. Look them up as necessary. These should be 
memorized for next year. Kilo- has been completed as an example. 

Prefix Power Symbol 
Giga- 
Mega- 
Kilo- 103 k 
Centi- 
Milli- 
Micro- 
Nano- 
Pico- 

Not only is it important to know what the prefixes mean, it is also vital that you can convert between metric 
units. If there is no prefix in front of a unit, it is the base unit which has 100 for its power, or just simply “1”. 
Remember if there is an exponent on the unit, the conversion should be raised to the same exponent as well. 

Convert the following numbers into the specified unit. Use scientific notation when appropriate. 

1. 24 g = _______ kg

2. 94.1 MHz = _______ Hz

3. 6 Gb = ________ kb

4. 640 nm = ________ m

5. 3.2 m2 = ________ cm2

6. 40 mm3 = _______ m3

7. 1 g/cm3 = _______ kg/m3

8. 20 m/s = _______ km/hr

For the remaining scientific notation problems you may use your calculator. It is important that you know how 
to use your calculator for scientific notation.  The easiest method is to use the “EE” button. An example is 
included below to show you how to use the “EE” button. 

Ex: 7.8x10-6 would be entered as 7.8“EE”-6 

9. (3.67x103)(8.91x10-6) =

10. (5.32x10-2)(4.87x10-4) =

11. (9.2x106) / (3.6x1012) =

12. (6.12x10-3)3



Part 2: Geometry 

Calculate the area of the following shapes.  It may be necessary to break up the figure into common shapes. 

1.        2. 

Area = ________ Area = ________ 

Calculate the unknown angle values for questions 3-6. 

3. 4. 

Lines m and n are parallel. 

A =   75° B = _____ C = _____ D = _____ 
θ = 16°  

ϕ = ______ E = _____ F = _____ G = _____ H = _____ 

5. 6. 

θ1 = _____ 

θ2 = _____ 

 θ3 = _____ 

θ4 = _____ A = _____ B = _____ 

θ5 = _____ C = _____ D = _____ 

15 m 

7 m 

6 m 

12 m 
16 m 

22 m 

18 m 

θ

ϕ

A B 
C D 

E F 
G H 

m 

n 

θ1 θ1 

θ2 
θ3θ4 

θ5 

70° 
θ

A B 

C 

D 

θ = 37° 

60° 



Part 4:  Trigonometry 

Write the formulas for each one of the following trigonometric functions. Remember SOHCAHTOA! 

sinθ = cosθ = tanθ = 

Calculate the following unknowns using trigonometry. Use a calculator, but show all of your work. Please 
include appropriate units with all answers. (Watch the unit prefixes!) 

1. 2. 3. 

y = _______ dx = ______ x = _____ 

x = _______ dy = ______ y = _____ 

4.  5.  6. 

c = ______ R = ______ d = ______ 

θ = ______ θ = ______ θ = ______ 

7. 8. 9. 

y = ______ x = ______ R = ______ 

θ = ______ d = ______ θ = ______ 

θ
θθ

θ θθ

θ
θ

θ

y 

y 

dy 
x 

x 

x 

d 

R 

d 

R 

c 

y 

θ = 60° 

dx 

θ = 30° θ = 17° 

θ = 26° 

12 m 

59.3 km 

1.4 m 

2.3 mm 
17 m 

39.8 m 

6.7 m 

13.7 m 

21.6 km 



You will need to be familiar with trigonometric values for a few common angles. Memorizing this unit circle 
diagram in degrees or the chart below will be very beneficial for next year in both physics and pre-calculus. 
How the diagram works is the cosine of the angle is the x-coordinate and the sine of the angle is the y-
coordinate for the ordered pair. Write the ordered pair (in fraction form) for each of the angles shown in the 
table below 

Refer to your completed chart to answer the following questions. 

10. At what angle is sine at a maximum?

11. At what angle is sine at a minimum?

12. At what angle is cosine at a minimum?

13. At what angle is cosine at a maximum?

14. At what angle are the sine and cosine equivalent?

15. As the angle increases in the first quadrant, what happens to the cosine of the angle?

16. As the angle increases in the first quadrant, what happens to the sine of the angle?

θ cosθ sinθ 

0° 
30° 
45° 

60° 

90° 

30° 

45° 

60° 

90° 

0° 



Use the figure below to answer problems 17 and 18. 

17. Find an expression for h in terms of l and θ.

18. What is the value of h if l = 6 m and θ = 40°?

Part 5: Algebra 

Solve the following (almost all of these are extremely easy – it is important for you to work independently). Units on the 
numbers are included because they are essential to the concepts, however they do not have any effect on the actual 
numbers you are putting into the equations. In other words, the units do not change how you do the algebra. Show every 
step for every problem, including writing the original equation, all algebraic manipulations, and substitution! You should 
practice doing all algebra before substituting numbers in for variables. 

Section I: For problems 1-5, use the three equations below: 

𝑣 = 𝑣 + 𝑎𝑡 𝑥 = 𝑥 + 𝑣 𝑡 + 1
2𝑎𝑡  𝑣 = 𝑣 + 2𝑎(𝑥 − 𝑥 ) 

1. Using equation (1) solve for t given that v0 = 5 m/s, vf = 25 m/s, and a = 10 m/s2.

2. a = 10 m/s2, x0 = 0 m, xf = 120 m, and v0 = 20 m/s. Use the second equation to find t.

3. vf = - v0 and a = 2 m/s2. Use the first equation to find t / 2.

4. How does each equation simplify when a = 0 m/s2 and x0 = 0 m?

Section II: For problems 6 – 11, use the four equations below.

Σ𝐹 = 𝑚𝑎 
𝑓 = 𝜇 𝑁 

𝑓 ≤ 𝜇 𝑁 

𝐹 = −𝑘𝑥 

5. If Σ𝐹 = 10 N and a = 1 m/s2, find m using the first equation.

6. Given  Σ𝐹 = 𝑓  , m = 250 kg, 𝜇 = 0.2, and N = 10m, find a.

7. Σ𝐹 = T – 10m, but a = 0 m/s2. Use the first equation to find m in terms of T.

8. Given the following values, determine if the third equation is valid. Σ𝐹 = 𝑓  , m = 90 kg, and
a = 2 m/s2. Also,  𝜇 = 0.1, and N = 5 N.

9. Use the first equation in Section I, the first equation in Section II and the givens below, find Σ𝐹.
m = 12 kg, v0 = 15 m/s, vf = 5 m/s, and t = 12 s.

10. Use the last equation to solve for Fs if k = 900 N/m and x = 0.15 m.

l 

θl 

h 



Section III: For problems 12, 13, and 14 use the two equations below. 

𝑎 = 𝑣
𝑟

𝜏 = 𝑟𝐹𝑠𝑖𝑛𝜃 

11. Given that v is 5 m/s and r is 2 meters, find a.

12. Originally, a = 12 m/s2, then r is doubled. Find the new value for a.

13. Use the second equation to find θ when τ = 4 Nm, r = 2 m, and F = 10 N.

Section IV: For problems 15 – 22, use the equations below.

𝐾 = 1
2𝑚𝑣  

Δ𝑈 = 𝑚𝑔ℎ 

𝑊 = 𝐹(Δ𝑥)𝑐𝑜𝑠𝜃 

𝑈 = 1
2𝑘𝑥  

𝑃 = 𝑊
𝑡

𝑃 = 𝐹𝑣 𝑐𝑜𝑠𝜃 

14. Use the first equation to solve for K if m = 12 kg and v = 2 m/s.

15. If ∆Ug = 10 J, m = 10 kg, and g = 9.8 m/s2, find h using the second equation.

16. K = ∆Ug, g = 9.8 m/s2, and h = 10 m. Find v.

17. The third equation can be used to find W if you know that F is 10 N, ∆x is 12 m, and θ is 180°.

18. Given Us = 12 joules, and x = 0.5 m, find k using the fourth equation.

19. For P = 2100 W, F = 30 N, and θ = 0°, find vavg using the last equation in this section.

Section V: For problems 23 – 25, use the equations below. 

𝑝 = 𝑚𝑣 𝐹Δ𝑡 = Δ𝑝 Δ𝑝 = 𝑚Δ𝑣 

20. p is 12 kgm/s and m is 25 kg. Find v using the first equation.

21. “∆” means “final state minus initial state”. So, ∆v means vf – vi and ∆p means pf – pi. Find vf using the third
equation if pf = 50 kgm/s, m = 12 kg, and vi and pi are both zero.

22. Use the second and third equation together to find vi if vf = 0 m/s, m = 95 kg, F = 6000 N, and
∆t = 0.2 s.

Section VI: For problems 26 – 28 use the three equations below. 

𝑇 = 2𝜋 𝑚
𝑘 𝑇 = 2𝜋 𝑙

𝑔
𝑇 = 1

𝑓

23. Tp is 1 second and g is 9.8 m/s2. Find l using the second equation.

24. m = 8 kg and Ts = 0.75 s. Solve for k.

25. Given that Tp = T, g = 9.8 m/s2, and that l = 2 m, find f (the units for f are Hertz).



Section VII: For problems 29 – 32, use the equations below. 

𝐹 = −𝐺𝑀𝑚
𝑟 𝑈 = −𝐺𝑀𝑚

𝑟
26. Find Fg if G = 6.67 × 10-11 m3 kg-1 s-2, M = 2.6 × 1023 kg, m = 1200 kg, and r = 2000 m.

27. What is r if Ug = -7200 J, G = 6.67 × 10-11 m3 kg-1 s-2, M = 2.6 × 1023 kg, and m = 1200 kg?

28. Use the first equation in Section IV for this problem. K = -Ug, G = 6.67 × 10-11 m3 kg-1 s-2, and
M = 3.2 × 1023 kg. Find v in terms of  r.

29. Using the first equation above, describe how Fg changes if r doubles.

Section VIII: For problems 36 – 41 use the equations below. 

𝑉 = 𝐼𝑅 

𝐼 = Δ𝑄
𝑡

𝑃 = 𝐼𝑉 

𝑅 = 𝜌𝑙
𝐴

𝑅 = (𝑅 + 𝑅 + 𝑅 +⋯+ 𝑅 ) = Σ𝑅  

1
𝑅 = 1

𝑅 + 1
𝑅 + 1

𝑅 +⋯+ 1
𝑅 = 1

𝑅

30. Given V = 220 volts, and I = 0.2 amps, find R (the units are ohms, Ω).

31. If ∆Q = 0.2 C, t = 1s, and R = 100 Ω, find V using the first two equations.

32. R = 60 Ω and I = 0.1 A. Use these values to find P using the first and third equations.

33. Let RS = R. If R1 = 50 Ω and R2 = 25 Ω and I = 0.15 A, find V.

34. Let RP = R. If R1 = 50 Ω and R2 = 25 Ω and I = 0.15 A, find V.

35. Given R = 110 Ω, l = 1.0 m, and A = 22× 10-6 m2, find ρ.

Part 6: Graphing and Functions 

A greater emphasis has been placed on conceptual questions and graphing on the AP exam. Below you will find 
a few example concept questions that review foundational knowledge of graphs. Ideally you won’t need to 
review, but you may need to review some math to complete these tasks. At the end of this part is a section 
covering graphical analysis that you probably have not seen before: linear transformation. This analysis 
involves converting any non-linear graph into a linear graph by adjusting the axes plotted. We want a linear 
graph because we can easily find the slope of the line of best fit of the graph to help justify a mathematical 
model or equation. 



Key Graphing Skills to remember:  

1. Always label your axes with appropriate units. 
2. Sketching a graph calls for an estimated line or curve while plotting a graph requires individual data 

points AND a line or curve of best fit. 
3. Provide a clear legend if multiple data sets are used to make your graph understandable. 
4. Never include the origin as a data point unless it is provided as a data point. 
5. Never connect the data points individually, but draw a single smooth line or curve of best fit 
6. When calculating the slope of the best fit line you must use points from your line. You may only use 

given data points IF your line of best fit goes directly through them. 
 

Conceptual Review of Graphs 

 

 

 

 

 



Linear and Non-Linear Functions 

You must understand functions to be able linearize. First let’s review what graphs of certain functions looks 
like. Sketch the shape of each type of y vs. x function below. k is listed as a generic constant of proportionality. 

 Linear   𝑦 = 𝑘𝑥 Inverse 𝑦 = 𝑘 𝑥 Inverse Square  𝑦 = 𝑘 𝑥  Power 𝑦 = 𝑘𝑥  



You will notice that only the linear function is a straight line. We can easily find the slope of our line by 
measuring the rise and dividing it by the run of the graph or calculating it using two points. The value of the 
slope should equal the constant k from the equation. 

Finding k is a bit more challenging in the last three graphs because the slope isn’t constant. This should make 
sense since your graphs aren’t linear. So how do we calculate our constant, k? We need to transform the non-
linear graph into a linear graph in order to calculate a constant slope. We can accomplish this by transforming 
one or both of the axes for the graph. The hardest part is figuring out which axes to change and how to change 
them. The easiest way to accomplish this task is to solve your equation for the constant. Note in the examples 
from the last page there is only one constant, but this process could be done for other equations with multiple 
constants. Instead of solving for a single constant, put all of the constants on one side of the equation. When you 
solve for the constant, the other side of the equation should be in fraction form. This fraction gives the rise and 
run of the linear graph. Whatever is in the numerator is the vertical axis and the denominator is the horizontal 
axis. If the equation is not in fraction form, you will need to inverse one or more of the variables to make a 
fraction. First let’s solve each equation to figure out what we should graph. Then look below at the example and 
complete the last one, a sample AP question, on your own. 

State what should be graphed in order to produce a linear graph to solve for k. 

Inverse Graph     Vertical Axis:_____________________ Horizontal Axis: ____________________ 

Inverse Square Graph  Vertical Axis:_____________________ Horizontal Axis: ____________________ 

Power (Square) Graph Vertical Axis:_____________________ Horizontal Axis: ____________________ 

Chemistry Example 

Let’s look at an equation you should remember from chemistry. According to Boyle’s the law, an ideal gas 
obeys the following equation 𝑃 𝑉 = 𝑃 𝑉 = 𝑘. This states that pressure and volume are inversely related, and 
the graph on the left shows an inverse shape. Although the equation is equal to a constant, the variables are not 
in fraction form. One of the variables, pressure in this case, is inverted. This means every pressure data point is 
divided into one to get the inverse. The graph on the left shows the linear relationship between volume V and 
the inverse of pressure 1/P. We could now calculate the slope of this linear graph. 

      



Sample AP Graphing Exercise 

A steel sphere is dropped from rest and the distance of the fall is given by the equation 
𝐷 = 𝑔𝑡 . D is the distance fallen and t is the time of the fall. The acceleration due to 
gravity is the constant known as g. Below is a table showing information on the first 
two meters of the sphere’s descent.  

a) Draw a line of best fit for the distance vs. time graph above.
b) If only the variables D and t are used, what quantities should the student graph in order to produce a

linear relationship between the two quantities?

c) On the grid below, plot the data points for the quantities you have identified in part (b), and sketch the
straight-line fit to the points. Label your axes and show the scale that you have chosen for the graph.

d) Calculate the value of g by using the slope of the graph.



Part 7: Scalars and Vectors Preview 

Hooray for the Internet! Watch the following two videos. For each video, summarize the content Mr. Khan is presenting 
in three sentences. Then, write at least one question per video on something you didn’t understand or on a possible 
extension of the elementary concepts he presents here. 

http://www.khanacademy.org/science/physics/v/introduction-to-vectors-and-scalars 

Summary 1 

http://www.khanacademy.org/science/physics/v/visualizing-vectors-in-2-dimensions 

Summary 2 

Congratulations! You’re finished! That wasn’t so bad was it? Trust me… the blood, sweat, and tears it took to 
get through all of those problems will make everything later on a lot easier. Think about it as an investment with 
a guaranteed return.

This course is a wonderful opportunity to grow as a critical thinker, problem solver and great communicator. 
Don’t believe the rumors- it is not impossibly hard. It does require hard work, but so does anything that is
worthwhile. You would never expect to win a race if you didn’t train. Similarly, you can’t expect to do well if 
you don’t train academically. AP Physics is immensely rewarding and exciting, but you do have to take notes, 
study, and read the book (gasp!). I guarantee that if you do what is asked of you that you will look back to this 
class with huge sense of satisfaction! I know I can’t wait to get started…

Let’s learn some SCIENCE!!!

http://www.khanacademy.org/science/physics/v/introduction-to-vectors-and-scalars
http://www.khanacademy.org/science/physics/v/visualizing-vectors-in-2-dimensions
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Vectors	
	
	
Vectors	often	are	expressed	in	ijk,	or	unit	vector,	notation.		For	example,	a	3-
dimensional	velocity	vector	v	would	be	expressed	as:			
	

v	=	vxi	+	vyj	+	vzk	,	
	

where	i,	j,	and	k	are	unit	vectors	in	the	x,	y,	and	z	directions,	respectively.	
	
	
Assume	a	particle	starts	at	the	origin	and	moves	2	m	in	the	x-direction,	3	m	in	y-
direction,	and	4	m	in	the	z-direction.		Express	the	displacement	of	the	particle	from	
origin	as	a	vector	d	in	unit	vector	notation.	
	
	
	
	
	
Find	the	angle	that	this	vector	forms	with	the	xz-plane.	
	
	
	
	
	
	
	
Find	the	angle	that	this	vector	form	with	the	xy-plane	
	
	
	
	
	
	
	
Recall	that	there	are	2	ways	to	multiply	vectors.		The	dot,	or	scalar,	product	results	
in	scalar,	not	a	vector.		The	cross	product,	or	the	vector	product,	results	in	a	vector.		
The	dot	product	of	2	vectors	F	and	d	is:	
	
F	=	Fxi	+	Fyj	+	Fzk	 	 	 	 d	=	dxi	+	dyj	+	dzk	
	

F	.	d	=	Fxdx	+Fydy	+	Fzdz	
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The	cross	product	is:	
	

F	x	d	=			
𝑖 𝑗 𝑘
𝐹𝑥 𝐹𝑦 𝐹𝑧
𝑑𝑥 𝑑𝑦 𝑑𝑧

						=	(Fydz	–	Fzdy)i	+	(Fzdx	–	Fxdz)j	+	(Fxdy	–	Fydx)k	

	
	
Find	F	.	d	if		F	=	-i	+	8j	-	5k	and	d	=	2i	+	3j	+	4k		
	
	
	
	
	
	
Find	F		x	d	if		F	=	-i	+	8j	-	5k	and	d	=	2i	+	3j	+	4k	
	
	
	
	
	
	
	
Find	the	magnitude	of	F	x	d	above.	
	
	
	
	
	
	
	
Find	the	angle	between	the	vectors	F	and	d	above.	
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Excel-Based	Data	Table	and	Graphing	Exercise	
	
You	are	tasked	with	recreating	exactly	the	Excel	spreadsheet	and	graph	below.		You	
must	use	Excel,	as	it	is	the	King	standard.		Begin	your	work	in	cell	A1,	enter	the	
proper	data	and	titles,	and	format	as	shown.	
	
Using	the	values	in	cells	C2	to	C5	and	the	appropriate	functions	and	operators	in	
Excel,	you	must	calculate	the	predicted	values	in	cells	D10:E25.		Predicted	values	for	
the	horizontal,	or	x	position,	can	be	computed	from	the	function:	
	

x(t)	=	x(0)	+	v0	cos(ø)	t,	
	

where	x(t)		is	the	horizontal	position	in	meters	at	time	t,	x(0)	is	the	initial	horizontal	
position	in	meters,	v0	is	the	initial	velocity	in	meters/second,	and	ø	is	the	angle	with	
the	horizontal	in	degrees.		Predicted	values	for	the	vertical,	or	y	position,	can	be	
computed	from	the	function:	
	

y(t)	=	y(0)	+	v0	sin(ø)	t	–	4.9	t2,	
	

where	y	is	the	vertical	position	in	meters	at	time	t,	y(0)	is	the	initial	vertical	position	
in	meters,	v0	is	the	initial	velocity	in	meters/second,	and	ø	is	the	angle	with	the	
horizontal	in	degrees.	
	
For	the	time	and	observed	values	of	position,	simply	enter	the	numerical	data	that	
are	given.	
	
Use	the	data	in	cells	A10:A25,	B10:B25	and	D10:D25	to	plot	the	graph.		Refer	to	the	
attached	document	from	Dr.	Castonguay	on	plotting	graphs	with	Excel	or	search	for	
‘how	to	make	a	graph	in	Excel’	on	the	web	and	choose	a	link.		(The	King	science	
teachers	will	be	posting	a	video	on	graphs	in	Excel	over	the	summer).	
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Making	Graphs	with	Excel	
By	

Dr.	Castonguay	
	

Background	and	Summary	
 

Scientists use graphs to communicate their data and results to each other 
and to society.  You must learn how to create graphs that will enhance your data 
presentation in lab reports.  This document explains the basics of creating a 
graph from a MS Excel spreadsheet.  You are welcome to use any other graphing 
program that you are familiar with, so long as the graph is clear and follows the 
formatting conventions of chemistry. 
 
Making a Graph with Excel 

Consider the following experimental data.  A student weighed three 
different samples of aluminum and found the volume of those three samples.  
These are the measurements: 
 
Sample Volume (mL)  Mass (g) 
1  3.80   10.00 
2  3.60   9.89 
3  4.32   11.50 
 
Create a Spreadsheet 
1.  Open a new blank Excel document.  This is a spreadsheet. 
 
2.  Each box is called a “cell” and can hold a piece of data.  The cells are identified 
by the column (a letter) and the row (a number).  The first cell is A1.  Type 
“Sample” in A1, “Volume (mL)” in B1, and “Mass (grams)” in C1.  If the text is 
too long for the default width of the column, double click on the line that 
separates that column from the one to its right.  This automatically resizes the 
column to fit the text you have entered.  
 
3.  Fill the appropriate data into columns A, B, and C in rows 2-4.  Put one value 
in each cell. 
 
4.  Excel will sometimes automatically format data you enter in an unsuitable 
way.  For example, it sometimes truncates tailing zeros.  But sometimes those  
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zeros are significant figures and we want them to be displayed.  To control how 
the number in a given cell is formatted, right click on the cell.  Choose “Format 
cells” from the menu.  The “Format Cells” box appears.  The options you will use 
most often are “Number” or “Scientific”.  “Number” displays numbers with the 
selected number of decimal places.  “Scientific” displays numbers in scientific 
notation, where 2.99E+08 represents the number 2.99 x 108.  For this set of data, 
choose “Number” and set the number of decimal places to two. 
 
5.  In the “Format Cells” window you can also change the font, size, alignment, 
etc. 
 
Entering a Formula 
 Excel will carry out calculations on long columns of data via the formula 
entry function.  Say we’d like to calculate the density of samples 1, 2, and 3 from 
our mass and volume measurements.  We don’t have to enter each quotient into 
a calculator and record the results in Excel; we can ask Excel to do the calculation 
for us. 
1. Type “Density (g/mL)” into cell D1 as a title. 
 
2.  Select cell D2.  Now type:  =C2/B2  and hit return.  This tells Excel that the 
value to display in cell D2 is the quotient of the values in cell C2 and cell B2.  
Two other options:  With cell D2 selected, you can type “=C2/B2” into the 
Formula Entry bar, labeled “fx”, at the top of the spreadsheet.  Or, you can type = 
into cell D2, then click on cell C2, then type / , then click on cell B2.  This also 
produces the formula  =C2/B2 in cell D2.  A formula always begins with the 
equals sign.  Once you type “=” in a cell, clicking on any other cell will result in 
that cell being entered into your equation.  This makes typing equations a lot 
faster!  But be careful that you click on the correct cells. 
 
3.  We’d like Excel to do the same calculation on rows 3 and 4.  To do this, click 
once on cell D2 to select it.  There is a black square in the bottom right corner of 
the cell.  Hover the cursor over this square and the cursor becomes a black + sign.  
Hold down the left mouse button and drag down to the bottom of cell D4.  
Dashed lines appear around cells D2 to D4; this indicates that the formula will be 
entered into all of these cells.  Release the mouse button.  Double-click on cell D4; 
the formula that has been entered into this cell appears.  Also, if you select cell 
D4 by clicking on it once, the formula appears in the formula entry bar at the top 
of the spreadsheet. 
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With three data points, it may not seem onerous to calculate the density of each 
sample by hand.  But imagine if you had 100 or even 10,000 data points in each of 
columns B and C.  You’d want Excel to calculate the next data column for you! 
 
4.  We probably want to calculate the average of our three experimentally 
determined densities.  We can ask Excel to do that too.  Click on cell D5 and type 
“=AVERAGE(D2:D4)” and hit return.  The function AVERAGE is a pre-
programmed command in Excel.  The (D2:D4) part tells Excel which cells to take 
the average of—all of the cells from D2 to D4.  There are many other useful 
preprogrammed functions, like SUM (which adds all of the values in the 
indicated cells), ROWS (which displays how many cells there are in the indicated 
range), and STDEV (which calculates the standard deviation of the numbers in 
the indicated cells).  You can learn more about the preprogrammed functions 
using the Help menu in Excel. 
 
Making a Graph 
1.  Highlight cells B2 through C4 (this amounts to the six cells containing the 
volume and mass data).  Do not highlight the cells with the titles or the cell with 
the average density. 
 
2.  Click on the tab called “Insert” in the menu bar.  Choose “Scatter” and you 
will see several options for your plot.  Choose the icon that has only data markers 
and no lines.  A graph appears in the Excel sheet. 
 
3.  Click anywhere on the graph area to select it.  In the menu bar there are three 
tabs under “Chart Tools” called “Design”, “Layout”, and “Format”.  We will use 
these to make the graph look exactly how we want it to look. 
 
4.  First, let’s change the minima and maxima on the X and Y axes so that the 
points are displayed nicely in the plot area, without a lot of empty space.  Click 
on the “Layout” Tab.  Choose “Primary Horizontal Axis” and then “More 
Primary Horizontal Axis Options”.  A window appears.   Change “minimum” to 
“fixed” and type “3.4” into the box.  The X-axis of your graph will now begin at 
3.4 mL and the whole plot area is filled with the data points.  If you need to 
change the axis limits on the Y-axis, do so using the same procedure but select 
the vertical axis options. 
 
5.  Axis titles:  In the “Layout” tab in the menu bar, choose “Axis Titles” and add 
a horizontal and vertical title to the graph.  Click on the text boxes that say “Axis 
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Title” to edit the text and type in “Mass (g)” and “Volume (mL)”.  Right click on 
the text boxes to change the font, size, etc.  Please make the font size 12 or larger!  
 
6.  Legend:  If you only have one series of data points in a graph, there is no need 
for a legend because we don’t need to distinguish one set of graph markers from 
another.  So for this plot, either click on the legend in the plot area and hit 
“delete”, or click on “Legend” in the “Layout” tab and choose “None”. 
 
7.  Gridlines:  For most of the plots you create in this class, you will not need 
gridlines.  Click on “Gridlines” in the “Layout” tab and select “None” for both 
horizontal and vertical.  If you ever need gridlines on a plot, you should have 
both horizontal and vertical gridlines, not one or the other.   
 
Now you should have a plot that looks pretty much like this: 
 

 
Adding a Trendline 

 
We asked Excel to calculate the average of the three measured densities.  We can 
also determine the density from the Mass/Volume data by finding the slope of 
the line that fits our three data points in the plot above.  Recall that the slope = 
∆y/∆x.  In our plot, the y axis is Mass (g) and the x axis is Volume (mL), giving us 
a slope with units of g/mL; recall that d = m/V, so m = d*V.  To get Excel to plot 
the best-fit line to these three data points: 
 
1.  Click anywhere on the plot area to select it.  
 
2.  Click on the “Layout” tab in the menu bar.  Choose “Trendline”, then “Linear 
Trendline”.  A line appears on your plot. 
 
3.  We want to know what the equation of that best-fit line is.  The equation will 
take the form y = mx + b, where y = mass, x = volume, m = slope = density, and b 
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is the y-intercept.  Click on “Trendline” and choose “More Trendline Options” at 
the bottom.  A window appears. 
 
4.  Check the boxes for “Display equation on chart” and “Display R-squared 
value on chart”.  The equation for the best-fit line appears on the chart.  So does 
the value of R2, which is a parameter that tells you how well the best-fit line 
actually fits to your data.  An R2 value greater than 0.95 is often acceptable, 
depending on what kind of data you are fitting. 
 
5.  To change the font or size of the equation and R2 value, right click on the text 
box.  You can also drag the text box to any location on the plot area.  Do not 
block the points or the line with the equation.  Now you should have a plot that 
looks something like this: 

 
6.  The equation of the line is y = 2.3663*x + 1.2189.  The slope of the line is 2.3663; 
we can report the density as 2.37 g/mL (with the appropriate number of 
significant digits).  To change how many digits are displayed in the equation,  
double-click on the text box that contains the equation.  The “Format Trendline 
Label” box appears.  In the left-hand menu, choose Number and then for 
Category, choose Number and set the number of decimal places you want to 
display in order to report the number with the correct number of significant 
digits. 
 
Figure Caption 
 In the chemical literature, plots are considered Figures and they are 
numbered and given captions.  Captions always appear below the plot.  To add a 
caption to your plot for a lab report, copy and paste your plot into a Word 
document and type the caption below the plot.  You can add a caption in Excel, 
but when you resize the plot in Word it often becomes difficult to read.  Typing 
in Word is always legible.  Here is an example of a finished figure, with the 
correct significant digits in the equation and a caption: 
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Figure 1.  A plot of the mass vs the volume of three differently sized samples of 
aluminum.  The slope of the line is the experimentally measured density of 
aluminum, 2.37 g/mL. 
 
	


